Ingeniux CMS Training — Table of Contents

Section Page
Logging in 1
Site folder navigation 2
Checking out 4
Checking in 6
Publishing 7
Editing & formatting content 10
Uploading documents 15
Creating hyperlinks 21
Creating accordions 28
Logging out 36

Note: Click the page numbers to go directly to the page.



Logging In

1. (LOGIN) Go to www.sru.edu/IGX and the below page will appear on your screen. Your ‘User Name’ and ‘Password’ will be the same as your SRUNET
login. Click ‘Login’.

Example:
User: first.last (do not include “@sru.edu”)
Password: Your e-mail password

Note: You must use the newest iteration of Firefox, Chrome, or Safari (Mac only). Do not use Internet Explorer as the version installed on SRU work
computers is substantially dated. If you have administrative rights to your work computer, you can download/install/update any of the above. If you do
not, or are otherwise intimidated by this task, contact IATS to install/update one of the above browsers for you.

Troubleshooting/technical support will only be provided for Firefox and Chrome.

Firefox Download: www.firefox.com

Ingeniux CMS Login

websupport

Remember me



http://www.sru.edu/IGX
http://www.firefox.com/

Site Folder Navigation

1. (DASHBOARD) Once you login, you will see this dashboard below. Your navigation process will be done under the ‘Site’ tab on the top of the screen.
SlipperyRock Ingeniux Hosted Dev | Bushboant
SlipperyRock Ingeniux Hosted Dev Dashboard
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Click on the . icon in top left corner to open the site tree.

SlipperyRock Ingeniux Hosted Dev Dashboard

Content Store (x1)

Folder Content Properties
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Name
[} Site Folder
(i Internal Components
(im] Orphaned Pages
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2. (SITE FOLDER NAVIGATION) By clicking the triangles next to each item, the content within each subject or folder will expand. In order to see events
submitted to your area, you will need to navigate to your specific folder.

Note: Newly submitted events will always appear underneath the date folders in your corresponding section.

For an example, we will be selecting an event in the Events RSS Test Components folder called ‘Cyber Security Fair’. Single left click on the event that you

want to approve/edit.

NOTE: If you'll be accessing a page frequently, you can add it directly to your dashboard by entering the page number into the “Favorites” section.

Site Tree
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Checking Out, Checking In, and Publishing

Check Out

1. The user can navigate the site tree to find the page/event that needs to be checked out. Clicking on the page will select it and load its

information/content.

Dashboard
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Cyber Security Fair (x29343)

Edit Preview Categorize History XML Properties Analytics
@v Check Out A Assign To v @ - B D Publish + Q Show Path
Form View ~ [= ] This page must be checked out to you before you can edit it!
Title [Required] ®
Cyber Security Fair
Abstract ®
© > Date Options @ |
Location @
Smith Student Center Ballroom
Contact Name @
Stephen Larson
Contact Email @

stephen larson@sru.edu




2. If the page is not checked out, the user can check out the selected page by clicking the button labeled “Check Out” in the toolbar.

Cyber Security Fair (x29343)

Edit ‘ FPreview Categorize History HAML Prop

[&~ | check out o AssignTov @, mo gl

Form View ||:| 5|:||

Title [Required]

Make Changes
=

The user can then make any necessary changes to the page. Once any changes have been made, the user must save the page by clicking

Cyber Security Fair (x29343)

Edit ‘ Preview Design Categorize History XML Props

[3- checkin | B | =& Rename *% AssignTov @, wmo L

Form View ||:| 5|;||

Title [Required]




Check In

1. Once any changes have been saved, the user must check in the page by clicking on the button labeled “Check In” on the toolbar.
Note: The Check In button is located in the same position as the Check Out button was.

Cyber Security Fair (x29343)

Edit ‘ FPreview Design Categorize History AML FProp

(&~ | checkin %’ Rename *3% AssignTor @, mo L

Form View ||:|

Title [Required]



Publish

1. To publish the page and have it displayed on SRU’s website, the user can right click on the page in the site tree.
2. Inthe right-click menu displayed, click on the option labeled “Publish.”

Site Tree
& A
[J Web Comm Fol.
¥ [0 Events RSS Test Components
[ Cyber Seruritu Fair
AT ’
& Events| oV
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£ Events|
Refresh
& Events| 2s Me
Cut
& Events|
Copy
# RSSEve
& common Hour  pejete
» B Commenceme  ,qq io workflow
& celebration of  Assign To_. 3
|3 Right to Know
P [& Offices
Send Mail b
21 Web Privacy
P [B Deluxe
_ Check In
P [0 Staging
Undo Check Out
P [ Landing Pages
grag Rollback
3 404 , ,
Mark/Unmark for Publish
» B EventSubmissio . L
B University Contact]  pypiish
0 Test Events Page Properties
P [0 Test Area Paste without children
P [ Training Fol.




3. The user will see a pop up related to publishing a page. The user should select “Production” from this list.
4. The user should then click on “Incremental” to move to the next step of publishing.

Publish:
Select one or more targets to publish:
Filter Y
Publishing Target Last Publish Date
Production TM8M9 410 PM
« | i | »
»/ Perform Replication




5. The dialog may inform the user that there are no changes to the page. This usually happens when the page is already published. The user can click on the
“Proceed Anyway” button to continue, or the user can click on the “Cancel” button to review the page.

MNo Content changed since last publish »®

There are no pages and assets changed
since last publish. Do you want to cancel the
publish, or proceed anyway?

Procesd Anyvay

6. Click on “Close” to complete the publishing process.

Publish Submitted

The publish request was successfully
submitted. Do you want to monitor the
publish?

Close Monitor Publishes




Editing and Formatting Content

The Editor

The editor allows users to adjust content on their pages. Using the editor, users are able to:

e copy and paste content from another source into the editor

e bold and italicize words/phrases

e make a paragraph/sentence into a header, or a header into paragraph text

e insert links to pages within www.sru.edu, pages outside of www.sru.edu, documents, and emails
e insert lists of items using either ordered numbers or bullet points

The easiest view to use for the editor is the ‘Form View’. Click on the dropdown box labeled ‘Index View” and select ‘Form View’. Then click the rectangle to
open the view to ‘Full’.

EE

Copying and Pasting
When inserting content into the editor, the user can user Ctrl+V to paste text prepared elsewhere into the editor. As with all Web editors, it is generally best to
work within the editor most of the time, and only copy/paste into the editor when your material has already been prepared elsewhere.

Smart Paste

Smart Paste will attempt to keep any formatting the user has made in other programs. (Example: a link in Microsoft Word inserted using Smart Paste will
automatically fill out as many details as the source text can provide.) Smart Paste is the default setting.
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http://www.sru.edu/
http://www.sru.edu/

Contact Phone @'

3

@

Content [Required]
Edit= insert= View= Fomat= Table -

% * Fomas~ B J 5§ E X I E T F &

« Smart Phones, Stupid People: How to secure smart phones so as not to unintentionaly pass .+
along personal data - for IPhones and Android;

+ Social Media: Learn the penis of using social meda and how to protect personal information
on seddl networking sites;

= P@ssword: Viruses, malware and how Lo protect against them;

» Safe Browsing: How to surf the web safely

+ Do You Use Protection?: How and why to encrypt your data

» Using Pubbc PCs and Wi-Fi Hotspots: How to keep persenal information safe when using a
pubbcally avadable PC and/or Wi-fi hotspot.

= Securing Your Hame Wili: How Lo ensure no one is using your Will router

» Viruses and Malware: Keep ransomware out

The Cyber Security Fair fiyer & available here)

Plain Text Paste
Plain text pasting will accept any text from any source and insert it into the editor. The only sort of formatting retained is line breaking and spacing. To switch to
plain text paste, the user must click on “Paste as text” under the Edit tab. The user must toggle it off again to switch back to Smart Paste.

Content [Required]

Edit=  Insert~ View= Format~

4 Undo 4

le

he

ils
3 Cut

re
[h Copy £t

D) Paste ov
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v Paste as text ar
Ho
r

Select all
va

Find and replace
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Bold/Italics

When inserting content into the editor, the user might want to add emphasis to a word or phrase. The user can select a word or phrase within the editor; once
highlighted, the user can click on the “B” button to make it bold or the “1” button to make it jtalicized.

Note: Do not overuse bold, italicized, or fully capitalized text, as long stylized passages are harder to read.

Edit= Inset= View= Format= Table~r

) Formats ~ S

Headers and Paragraphs

Sometimes, you will need to add a header to a section of your content within the editor. This dropdown box is typically labeled ‘p‘.

Il
il
il
il
il
il
%

Content

Edit* Insert» Fomat~ Table~

« B 7 i=-:=- p -
This is a test page. You can utilize h2 :fore
within www.sru.edu.

|_h3 I
Editing Text: ha

Here is some text with a misspelled hs

Here is a space to practice copy (Ct  he .

Make this text bold (Ctri+B). _

Make this text italicized (Ctri+I).

Large Header

Users can make a large header (h2) by clicking anywhere within the body of a paragraph and expanding the dropdown box to select ‘h2.’
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THIS IS AN EXAMPLE HEADER

Student Center and AV] sponsor a free breakfast to students who are commuting frem their permanent address.

Medium Header

Users can make a medium header (h3) by clicking anywhere within the body of a paragraph and expanding the dropdown to select ‘h3.

THIS IS AN EXAMPLE HEADER

Student Center and AVI sponsor a free breakfast to students who are commuting from their permanent address.

Small Header

Users can make a small header (h4) by clicking anywhere within the body of a paragraph and expanding the dropdown box to ‘h4.’

THIS IS AN EXAMPLE HEADER

Student Center and AVI sponsor a free breakfast to students whe are commuting from their permanent address.

Paragraphs
Users can make a header back into a paragraph by clicking anywhere within the header and expanding the dropdown box to select ‘p.’

Content

Edit~ Insert Format= Table~

4« » B I =~ =~ n2 -

This is a test page. You can utilize _3fore

within www.sru.edu.

h3
Editing Text: ha
Here is some text with a misspelled h5
Here is a space to practice copy (Ct e 1.
Make this text bold (Ctri+B). P

Make this text italicized (Ctrl+1I).
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Creating Lists

Ordered Lists

If the user has items that need to be numbered on the page, they should enter each item and hit ‘ENTER’ before adding the next. This way, each item has its own
line. When all of the items are entered, highlight them all and click on the numbered list button.

Content [Required]

Edit~ Insert~ View~ Format~ Table~

) Formats~ B T & =

i
il
-

i
Ll
|
-~
i

= = = &
This is an example list:

L.
2.
3.

Unordered Lists

If the user has items that need to be in a list on the page but don’t need to be numbered, they should enter each item and hit ‘/ENTER’ before adding the next.
This way, each item has its own line. When all of the items are entered, highlight them all and click on the bulleted list button.
Content [Required]

Edit~ Insert~ View~ Format~ Table~

4 Formats~ B [T S =

= = = &

This is an example list:

JExample item 1

Removing Lists

To get rid of a list on a page, select all the items in the list and click on the highlighted list button (this will be the ordered or unordered list button, depending on
the type of list items selected).

14



Uploading Documents

1. Incertain instances, web pages may require a link to a document. For example, see the link for the ‘Department Fact Sheet’ on program detail pages.

PRE-ENGINEERING WITH PITT MAJOR
REQUIREMENTS

Curriculum Guide (PDF) This helpful guide lists Liberal/Rock Studies and Major Requirements, as well as electives,
core courses, and GPA requirements. Students can utilize this official curriculum guide, together with My Rock

Audit, to plan class schedules and satisfy graduation requirements:

e Curriculum Guide for Transfer Students (Liberal Studies)
# Curriculum Guide for New Freshman (Rock Studies)

Program Requirements and Course Descriptions are located in SRU's Academic Catalog. Students can utilize the
Academic Catalog to learn about specific courses, departments, and academic policies.

IDepartment Fact SheetIPDF] includes an overview of major, department highlights, and career opportunities.

2. Before alinkis created, the document must be uploaded into Ingeniux. To do this, first click on the ‘Assets’ button.

Administration

SlipperyRock Ingeniux Hosted Dev Dashboard

Site Tree Cyber Security Fair (x29343)
E iﬁ Edit Preview Design Categorize History
. . - Fe'| ABC .
~ @ SlipperyRock Ingeniux Hosted Dev “1 [&- checkin %’ Rename *3% AssignTo

* [1 Site Folder
Form View « 8 =0
* 4 Home

P [ AJAX
Title [Required]

b & Admissions
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3. The user must navigate through the ‘Assets’ folder site tree by clicking the small triangle next to ‘Documents’.

SlipperyRock Ingeniux Hosted Dev Dashboard

Assets Tree Assets
?E_ﬁ ] Folder
v @ Assets Cg Publish ~

IP [O documents I

P [O images

P [0 media T
» [ PreBuilt
»

[O stylesheets

» €& Recycle Folder

documents

17 items

4. The user must find the correct folder to add the folder based on what page the document will be used on. For example, if the document is going to be
used on the Academic Records page, you would navigate the tree as seen below.

v © Assets I Cg kg  checkout Pubish v

* [0 documents
» [ about
¥ [0 academics
¥ [0 academic-services
» [0 academic-records
[ rock-integrated-studies

» [0 students-with-disabilities

10034 Registration P... 10225 FERPA forr
[1 TutoringCenter.pdf 30 KB 161 KB

colleges

m

departments
honors-program
international-experiences
library

online-learning

research Academic_Calendar... Academic_Calend:
155 KB 211 KB

v v v v w v v w
cococoopoeoecrw

winter-summer-sessions
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Once the user is in the correct folder in the site tree, select the ‘Create new Asset’ button.

Folder Properties

C3 @ Check Out  Publish +

=] e

10034 Reqgistration P... 102253 FERPA form 7... 10274 Final Exam Sc... 11047 FALL
30 KB 161 KB 30 KB 757 KB

Once the upload box appears on screen, the user must make sure the boxes next to ‘Update existing assets for conflicting names’ AND ‘Use default
asset schema’ are checked and then select the button ‘Drag files here or click to browse a file’.

[‘a Check Out | Publish ~

size o— Q Search Y Filter

Ll

Drag files here

or click to browse a file

Updale existing assets for conflicting names Use default asset schema
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7. The user can now select the document to be uploaded. To finalize the selection, click on ‘Open’.

@ Open =]
@\J-v‘ v projects R o]
Organize New folder l @&

A Favorites * Name Date modified Type Size
Bl Desktop ingeniux-cms-training 8/5/20191237PM  Adobe Acrobat D... 1,500 KB

I8 Downloads

%l Recent Places

i Libraries
= Documents
&) Music
&) Pictures
B videos

18 Computer
&, Local Disk (C)
B coDrive®)In
S rpgl005§ (m:
G classwarks (W
G java$ (Wepscst
S pr_data (\\10.1
9 srudev (Wmsfu
3 webfiles (msl —

File name: ingeniux-cms-training

-
I Open I Cancel

8. The screen should now look like the one shown below. To complete the process of uploading a document, select ‘Upload’.

G

e}

Check Out

o

ingeniux-cms-trai...

Publish =

an Size
L L]

v Update existing assets for confiicting names

+ Use default asset schema

Q Search Y Filter

Close [ Uploau]



9. Once the document is finished uploading, refresh the folder and navigate to the new document in the assets tree. The user must first check the
document in by clicking the “Check In” button.

Ingeniux-CMS-Training (a/18351)

Owerdew | Calogorze | Hslory | Propenies

2 Rename  AssgnTo= e Pubishe Show Path
Properties @
Fie Hame Ingens CUS-Traming pat Asset D artsast
Fie Type: Document Upkoaded on danuary 9, 2020
e S 1.30 MB Upiosed try SUNETVRg 1005
Checked Out e
Current URL a

e Stant Dae. A End Duate. A
P
Schema ]
Txonony. °
5
10. Next, mark the document for publish by clicking on the icon. Check the “Marked for Publish” box and click “OK”.

Mark/Unmark assets for publish ®

Mark/Unmark the following 1 asset(s) for publish: a3811

| Publishing Target | Marked for Publish | Version to Publish |

‘ Current Version E

Production

11. Finally, click on the “Publish” dropdown and select “This Asset”.

Check Out % AssignTov @ wo [ Publish~

This Asset
Site

Properties
19



12. Select ‘Production’ as the ‘Publishing Target’, then click ‘Incremental’.

Publish- ®

Select one or more targets to publish:

Filter A ¢

Publishing Target | ast Publish Date
| Production B8/2/19 1:44 PM

< | 1] 3

/' Perform Replication

13. When the ‘Publish Submitted’ box shows up on screen, the user can hit ‘Close’. This will complete the document publishing. To create a link to this
document, please continue to the ‘Hyperlinks’ tutorial on the next page.

Publish Submitted b 4

The publish request was successfully
submitted. Do you want to monitor the
publish?

Monitor Publishes
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Hyperlinks

1. If the user wants to create a link, they can select the word/words that they’d like to be a link and click the “Insert/edit link” button that looks like chain
links under the ‘Insert’ dropdown box.

Content

Edit~ Insert~ Format= Table~

& AP nserveditlink | Ciisk

a. Another way to create a link is to select the word/words the user would like to be a link and right click it. This will display a menu where the user
can click “Insert/edit link.”

2. The user will be prompted for the type of link (internal, external, document, anchor, or email), destination, behavior, a short/minimal title, and the class
(internal, external, or anchor).

Internal Link
If the user wants to create a link to a page that begins with www.sru.edu, they can select the word, phrase, or sentence that should be a link and click the
“Insert/edit link” button as seen above in step 1.

1. Link To (Type): Select Internal

Insert/Edit Link

Link To

m () External () Asset () Anchor () E-Mail
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2. Page: There are two options when selecting an internal link page destination.
a. Type the name of the page being linked to and select it from the list of pages with that title, or
b. Type ‘X’ followed by the ID (#) of the page being linked to

Insert/Edit Link b 4

Link To

@ internal () External () Asset () Anchor () E-Mail
Link Properties
Title
Target Open in this window/frame ]
Class ‘ Not Set v|

22



3. Target: Select Open in this window/frame

Insert/Edit Link x

Link To

@ Internal () External () Asset () Anchor () E-Mail

Link Properties

Page Home (x6) Q

Title

Target | Open in this window/frame E||
Class Not Set - |

4. Title: A short/minimal description/title for the page that is being linked to

Insert/Edit Link x

Link To
@ Internal () External () Asset () Anchor O E-mall
Link Properties
Page Home (x6) Q
Title SRU Home Page
Target Open in this window/frame ]
Class Internal Link v|
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5. Class: Select Internal

Insert/Edit Link b4

Link To
@ internal () External () Asset () Anchor () E-Mail
Link Properties
Page Home (xE) Q
Title SRU Home Page
Target Open in this window/frame ]
Class ‘ Internal Link

6. When the user is finished editing the link information, they can click Insert to create the hyperlink.

24



External Link
If the user wants to create a link to a page that does not begin with www.sru.edu, they can select the word, phrase, or sentence that should be a link and click
the “Insert/edit link” button.

Link To: Select External

URL: Copy and paste the destination URL (example: http://news.yahoo.com/)
Target: Select Open in new window (_blank)

Title: A short/minimal description/title for the page that is being linked to
Class: Select External

Insert/Edit Link b4

Link To

vk wNe

() Internal @ External () Asset () Anchor () E-Mail

Link Properties
External wWww.sru.edu
Title SRU Home Page
Target Cpen in new window/frame M
Class External Link ]

Ccarcer J e
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Document Link
If the user wants to create a link to a PDF file, a Word document, etc., they can select the word, phrase, or sentence that should be a link and click the
“Insert/edit link” button.

1. Link To: Select Document
2. Document: The user can click on the square button to the right of this text box to open the Asset Browser. The user can find their document in the Asset
Browser by clicking the triangle beside a folder to expand/collapse until they find the folder that contains the document. Clicking on a Folder Name will
show its contents in the right panel. Find the document in this list, select it, and click ‘Select.’

»

¥ [0 documents —  # Name Size (KB) Type Date Modified
P [ about )
10034 Registration Page ONLY -201... 30.2 Document 4/19/16 8:10 AM
¥ [O academics :
¥ [ academic_services 10225 FERPA form 7-2016.pdf 161.22 Document  7/15/16 9:12 AM
O academic-records 1 10274 Final Exam Schedule 8-2016.pdf  30.04 Document  4/14/17 11:32 AM
[ rock-integrated-studies .
11047 FALL Bulletin 2-2017 pdf 756.96 Document  3/3/17 9:19 AM
[ students-with-disabilities
P [ colleges 500_600_Level_Permission_Post_Ba... 46.17 Document 12/7M17 7:41 AM
P [ departments 500_Level_Permission.pdf 68.85 Document  11/30/17 1:04 PM
[ honors-program .
academic-calendar-2017-2018 padf 210.52 Document  12/7/16 1:28 PM
P [ international-experiences
» 3 library Academic_Calendar.pdf 209.87 Document  1/23/18 512 AM
3 online-learning Academic Calendar 1819 pdf 154.82 Document  1/3/19 6:42 AM

3. Target: If the document is a PDF, the user should select Open in new window (_blank). Otherwise, the user should select Open in this window/frame.
4. Title: A short/minimal description/title for the page that is being linked to
5. Class: Select External
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Email Link
If the user wants to create a link to someone’s email, they can select the text that should be a link and click the “Insert/edit link” button.

Link To: Select Email
E-Mail: Enter the email address of the desired recipient

Target: Select Open in new window (_blank)
Title: Type ‘Email’ followed by the recipient’s name

Class: Select External
Insert/Edit Link b 4

vk wnN e

Link To
() Internal () External () Asset (O Anchor O E-mail
Link Properties
E-Mail websupport@sru.edu
Title Email websupport
Target Open in new window/frame "|
Class External Link ]
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Editing Accordions

1. Some pages contain “accordion” components. For example, the Council of Trustees page’s accordion can be seen below.

OQIOCIOIOIOIOIOIOIOIO O
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2. To edit the accordion, open the site tree and click on the item with accordion in its title.

3. Before the user can edit the accordion’s content, the user must click the ‘Check Out’ button show in the picture below.

P 2] Alumni
P [ Community

* [J Veterans

¥ [3 Veterans and Military-Related Admissions

£+ Veterans and Military-Related Admissions Accordion

£l support Organizations

[£l Returning or Leaving Active Duty

& veteran's Center
P & Give to SRU
P & News

Veterans and Military-Related Admissions Accordion (x1459)

Edit

Categorize History

AML

Properties

Analytics

29
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4. Open the tab the user wants to edit by clicking on the small arrow to the right of the corresponding tab.

Edit ‘ Categorize History AML Properties Analytics

[3' Check In ﬂ Rename ”"’3 Assign To = 'ﬁf’ ~ B¢ Publish =
Formview ¥ | | O =0 |
Accordions [Required] 2 ®

List Type: Component Quantity: 4 Add New

Accordionitem @ &L
e

Component: Transfer Admissions - Accordion tab

(V)
Accordionitem @ B

Component: Graduate Admissions - Accordion tak

Accordionitem @ &
Component: Post-Bacc Admissions - Accordion tal

Accordionitem ORI *
re

Component: Mon-Degree Admissions - Accordion ©

o
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5. Once the user clicks on the drop down arrow, the page should look like the one below. The user can edit the accordion title and content.

Accordionltem @ O
Component: Graduate Admissions - Accordion tab

@

Title [Required]

Graduate Admissions

Content [Required]

Edit+ Inset= View= Format= Table~

T
Pt

S @ Fomats~ B [ S =

Veterans and individuals currently serving in the military who have already completed a bachelors
(4-year) degree from an accredited university and wish to pursue graduate work at SRU, should

apply through Graduate Admissions.

Fowered by TingHMCE
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6. Once the user is finished editing the accordion tab’s information, the user can collapse the item with the small up arrow to the right of the
corresponding accordion item.

Accordionitem OREK

Component: Graduate Admissions - Accordion tab

Q
*

Title [Required]

Graduate Admissions

Content [Required] @

Edit+ Inset~ View= Format~ Table~

S ® Fomats~ B I S =

1]
il
[ ]
|
L'}
|
il
it
|'
il

&

Veterans and individuals currently serving in the military who have already completed a bachelors
(4-year) degree from an accredited university and wish to pursue graduate work at SRU, should
apply through Graduate Admissions.

Click here for more information. Fowered by TingHCE
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7. Once all of the editing is complete and the box being edited is collapsed, the user must ‘Save’ the accordion item.

Veterans and Military-Related Admissions Accordion (x1459)

Edit Categorize History AML Properties Analytics

[av Chechlnﬂ Rename ”B\"} Assign To = @', ¢ | Publish -

8. Once all of the editing is saved, the user must check the accordion back in by selecting the ‘Check In” button shown below.

Veterans and Military-Related Admissions Accordion (x1459)

Edit Categorize History XML Froperties Analytics

(&~ | checkin x> Rename *3% AssignTov @, wmo Puplish~
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9. In order to implement these edits, the user must publish the accordion. To do so, right click on the accordion that was edited and select ‘Publish’.

I T
Mew 3
Rename o o
Refresh
Cut

. Copy -

ik Ingeniux Hosted D¢ T
Paste

ilder
Delete

18
Add to Worlkflow

WJAX Assign To.. »

cademics Show History

ife at SRU Send Mail

bout Check Qut

tudents Check In

aculty and Staff Undo Check Out =
Rollback

amily

. Mark/Unmark for Publish

Iumni
Preview

‘ommunity .
Publish

eterans
Page Properties

Veterans and Milit:
] Paste without children
£ Veterans and Muntary-rRelatea Aamissions accordion
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10. Select ‘Production’ as the ‘Publishing Target’, then click ‘Incremental’.

Publish: ®

Select one or more targets to publish:

Filter Y

Publishing Target | ast Publish Date
| Production 8/2/19 1:44 PM

< 1 b

./ Perform Replication

Cancel Full Incremental

11. When the ‘Publish Submitted’ box shows up on screen, the user can hit ‘Close’. This will complete the accordion editing and publishing.

Publish Submitted %

The publish request was successiully
submitted. Do you want to monitor the
publish?

Monitor Publishes
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Logging Out

1. Once all of your work is completed within Ingeniux, you should sign out of your session by clicking the ‘Sign Out’ button.

Q . srufloater2 2

&  Edit your Profile
B Change Language »

&, Change Password
(V] Sign Out

Q, Show Path

This page must be checked out to you you can edit it!
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